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Before you begin
ask yourself these questions

Who is my audience and what do I 
want them to do with this info? Any next steps needed for your audience?

How can I simplify this more?

What’s the goal? What am I trying to 
say? Why should they care?

What background do audiences need? 
(prerequisite knowledge, tools, 
materials)

What medium will it be in? (in-
person, virtual)
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Telling your 
story
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Storyline 
frameworks
Four different approaches 
to tell your story depending 
on whether you wish to 
inspire, inform, persuade, 
or educate

Problem- 
solution-benefit

Use with…
Business or technical presentations, simple and direct info

Before-after 
bridge

Use with…
Persuasive pitches, changes in management

STAR
method

Use with…
Case studies, project recaps

Hero’s
journey

Use with…
Product launches, case studies, transformation stories
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Hero’s journey

Call-to-
adventure

Introduce a challenge or 
opportunity

2

Struggle & 
growth

Show the journey of 
overcoming obstacles

3

Ordinary 
world

Start with the status quo1

Victory & 
return

End with success and 
lessons learned4

Product launches

Case studies

Transformation 
stories

Great for…
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Problem-solution-benefit

Great for… Problem

Solution

Benefit

1

3

2

What’s broken or inefficient?

How do you fix it?

What’s the impact or value?

Business/technical 
presentations

Simple & direct info
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Before-after-bridge

Great for…

Persuasive pitches

Management change
Bridge

Explain how your idea/product 
gets them to a solution

2

After Paint a picture of the ideal 
future3

Before Describe the current 
pain or limitation1
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STAR method

Great for…

Situation

Task

Action

1

3
How

2

What’s going on?

What needs to be done?

What did you do?

Result 4 What happened?

Case studies

Project recaps
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Typical 
presentation 
types
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Executive Updates

PurposeAudience Additional info to include

A polished, concise, strategic 
readout communicating 
progress to inform high-level 
decisions and show alignment 
with business goals

Executives and senior 
leadership

• Big picture outcomes and 
impact

• Emphasize results, not 
processes

• Risks at a business level
• Resource needs, budget, 

strategic blockers
• Limit technical jargon
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Discovery Readouts

PurposeAudience Additional info to include

Share findings from research + 
initial investigation to inform 
stakeholders about what’s 
been learned and validate 
assumptions

Cross-functional teams, 
stakeholders, product 
managers

• Content focus should 
include insights, user 
needs, pain points, market 
analytics

• Use supporting information 
such as research, 
interviews, data analysis
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Solution Proposals

PurposeAudience Additional info to include

Present a specific 
plan/solution design/approach 
to solve a problem for approval 
and buy in from stakeholders

Decision-makers, technical 
leads, business sponsors

Make sure to use diagrams, 
specs, project plan, risks
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Status Updates

PurposeAudience Additional info to include

Provide a detailed snapshot of 
progress via day-to-day or 
week-to-week tasks.

Direct team members, project 
managers, mid-level 
stakeholders

Surface blockers, risks, 
dependencies, next steps, etc
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Presenting 
to different 
audiences
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Best practices for non-technical 
audiences
Stakeholders, greater AP&O org

Non-technical audience wants clarity and impact,
the what and why it matters with limited details

Use simple 
language, 

avoid jargon

Use analogies and 
stories to explain 

concepts

Focus on benefits, 
outcomes, and 

business impact

Keep slides 
clean and 

visuals intuitive
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Best practices for technical 
audiences
Engineering, TPMs, BI

Technical audiences want depth,
the how and why in detail plus data; include open questions

Be ready for 
detailed questions 

and deep dives

Include data, charts, 
and diagrams

Focus on technical 
challenges, solutions, 

and metrics

Use precise 
terminology
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Presentation elements Technical audience Non-technical audience

Audience background Deep understanding of subject, jargon 
familiar

Little to no technical background, jargon 
confusing

Purpose Share detailed info, get feedback on 
specifics

Inform, persuade, or explain high-level concepts

Content focus Technical details, architecture, data, 
methods

Business impact, benefits, high-level overview

Level of detail High detail, granular explanations Simplified, big-picture focus

Language and terminology Technical jargon and acronyms acceptable Avoid jargon; use plan, accessible language

Use of visuals Detailed diagrams, code snippets, data 
charts

Simple visuals, metaphors, analogies

Tone Analytics, precise, sometimes informal Clear, engaging, often storytelling

Pace Can be slower, more time for questions Faster, concise, less technical Q&A

Interaction Encourage deep questions, discussions Limited Q&A, focus on clarity and understanding

Technical vs. non-technical audience comparison
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Aim for a screen change (e.g., animation, transition, video) 
every :15-:20 seconds so the audience doesn’t lose 
interest. 

Increase font size as the screen size decreases; 
ensure your text has breathing room and a readable 
font.

Use a higher color contrast than normal and make sure 
your key points stand out from the rest of your slide; use 
bold to increase impact.

Keep animation as simple as possible and make sure 
they are purposeful.
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• Don’t just read the slides, call out the key 
points.

• Keep slides as simple as possible to avoid 
distracting from your message.

• The focus is on you so incorporate natural 
body language to connect with your 
audience.

In-person best practices
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General best 
practices for 
PowerPoint
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1. Visit this link to open the 2026 template file.

2. In PowerPoint, select File and choose Save as Template…

How do I access and use the 2026 template?

3. Enter a title for the template and click Save. 

https://nbcuni.sharepoint.com/:w:/r/sites/Sales_Enablement/Shared%20Documents/1.%20Product%20Marketing/WIP%20folders/Lisa%20WIP/Digital%20retargeting%20FAQs.docx?d=w77bfafe88354419bb18df828c3bb199a&csf=1&web=1&e=b4gYqP
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1. In PowerPoint, select File and choose New from Template…

How do I create a deck using the template?

2. Choose the 2026 template and click Create.
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1. In PowerPoint, select the slide you want 
to transfer.

2. Right click and select Copy from the 
drop-down.

How can I use inspo from other decks?

4. Click on the Paste drop-down and 
select Use Destination Theme. The 
slide will be pasted with the NBCU 2026 
theme and palette colors.  

3. Make you see a red horizontal line 
between slides.
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Which colors can I use?

#5DB527

#0013F5

#FF1A1A

#00CCFF #171717

#FFEA00

#B144FF

Hex codes
identify specific colors 
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1. Select the drop-
down arrow for Text 
Fill (e.g., Home tab) 
or Shape Fill (e.g., 
Shape Format tab).

2. Select More 
Colors… and the 
Colors dialog box 
will open.

How do I return to the color palette?

3. Check the hex code of your 
color (e.g., B144FF).

4. Ensure the RGB Sliders tab 
is selected at the top of the 
dialog box.

5. Enter the Hex Color # of 
your desired color.

6. Click Ok.

#B144FF
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1. Select the objects by holding down Shift and 
clicking on all of them.

How do I align objects horizontally?

These steps also work for 
aligning your objects to 
the right and center.

2. Go to the Shape Format tab and select the Align drop-down arrow.

3. Ensure there is a checkmark beside Align Selected Objects. 

4. To align these textboxes to the left, select Align Left.

Align to Slide will 
align your object(s) 
with the slide 
rather than other 
objects
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These steps also work for 
aligning your objects to 
the middle and bottom.

1. Select the objects by holding down Shift 
and clicking on all of them.

How do I align objects vertically?

2. Go to the Shape Format tab and 
select the Align drop-down arrow.

3. Ensure there is a checkmark 
beside Align Selected Objects. 

4. To align these three objects 
vertically, select Align Top.

Align to Slide will 
align your object(s) 
with the slide 
rather than other 
objects.
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1. Select the objects by holding down Shift 
and clicking on all of them.

How do I distribute objects evenly?

These steps also 
work for aligning your 
objects vertically.

2. Go to the Shape Format tab 
and select the Align drop-down 
arrow.

3. Ensure there is a checkmark 
beside Align Selected Objects. 

4. To evenly align these objects 
horizontally, select Distribute 
Horizontally.
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Data dos

Use charts, 
tables & graphs
to help visualize information.

Use pie charts
when you want your audience to 
understand how each slice relates 
to the whole.

Use line graphs 
to show trends
over time or for many 
categories; ensure multiple 
lines are in contrasting 
colors.
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Data dos, cont’d

Know when not to 
use a pie chart
• if you want your audience to 

remember distinct values or

• if there are more than five parts 
of a whole

Don’t overcomplicate things
just because it’s eye-catching
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Imagery best practices

Use photos, 
images & icons
to make your data more 
immediate and relatable.

Support & accentuate the tone
of your presentation and use complementary imagery.

Emphasize & 
support your data
rather than overshadow or 
distract. Select more muted 
images that won’t attract much 
focus. 
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Imagery best practices, cont’d

Use high-
quality photos 
to maintain your 
credibility.

Keep it simple 
and readable
and use photos spaced 
for copy.
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1. In PowerPoint, go to the Insert tab.

2. Click on the Chart drop-down.

3. Select Column and choose the type of column chart you want; the chart will 
appear on the slide.

How do I create a column chart using my data?

4. An Excel window will open with example data.

5. In Excel, edit the cells to align with your data.

Another way to edit your data

1. Make sure the chart is selected.

2. Go to the Chart Design tab and select Edit Data in 
Excel.

3. As you edit, the chart will update.
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1. In PowerPoint, go to the Insert tab.

2. Click on the Chart drop-down.

3. Select Pie and choose the type of pie chart you want; the chart will appear on 
the slide.

How do I create a pie chart using my data?

4. An Excel window will open, with example 
data included. 

5. In Excel, edit the cell to align with your data.

Another way to edit your data

1. Make sure the chart is selected.

2. Go to the Chart Design tab and select Edit 
Data in Excel.

3. As you edit, the chart will update.
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1. In PowerPoint, go to the Insert tab.

2. Click on the Chart drop-down.

3. Select Line and choose the type of line chart you want; the chart 
will appear on the slide.

How do I create a line chart using my data?

4. An Excel window will open, with example data included.

5. In Excel, edit the cells to align with your data. 

Another way to edit your data

1. Make sure the chart is selected.

2. Go to the Chart Design tab and select Edit Data in Excel.

3. As you edit, the chart will update.
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Browse icon imagery and/or official logos in 
this deck

Accessing images and icons

Explore custom NBCU consumer images in the NBCU consumer image library

Look for 
images in
folder categories or 
image tags

https://nbcuni.sharepoint.com/:p:/r/sites/materials/Shared%20Documents/Sales%20Materials%20and%20Resources%20Documents/1.%20One%20Platform/2.%20Product%20Marketing%20Materials/2025_2026%20Icons%20and%20Logos.pptx?d=wa7e297ecb2884e44adfa1943a5a38459&csf=1&web=1&e=e3ug15
https://nbcuni.sharepoint.com/sites/materials/SitePages/2022-Consumer-Images.aspx


38

Accessibility
The practice of making information meaningful 
and usable for all people regardless of ability
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Font, color, tables

Avoid all caps
to maintain readability. Words that all look the same are harder to read, plus 
screen readers may read all caps as acronyms.

Choose a sans-serif font
for increased readability.
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Font, color, tables, cont’d

Use simple table structures
and organize information so screen readers can navigate the 
cells in a logical order. 

Don’t use color alone
and make sure it’s not the only way of conveying info, allowing those who 
are blind or with low vision to have the same presentation experience. 
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Font, color, tables, cont’d

Review language 
and ensure your writing is inclusive, concise, and clear. Don’t overcrowd 
slides. Define acronyms the first time they appear.

Helpful hyperlinks
are descriptive and accurate, providing info about the 
destination of the link.
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What is alt text?
Brief text description of an image read by screen readers to provide info 
about the image’s purpose. 

Don’t just describe what the image contains but provide context.

What is alt text and how do I write it?

Best practices
Keep it short, 1-2 sentences

Consider key elements instead of little details

Don’t say “image of” or “picture of”

Include if it is a logo, icon, or illustration

End alt text with a period

No alt text needed if the image is solely decorative 

Poor alt text: “People exercising”

Useful alt text: “Two athletes running stairs at a stadium.”
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1. Select the image you want to add alt text to.

How do I add alt text to images?

2. Go to the Picture Format tab, select Alt Text, 
and the Alt Text panel will open.
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1. In PowerPoint, go to the Review tab.

2. Select the Check Accessibility drop-down and 
choose Check Accessibility. The Accessibility 
Assistant panel will open. 

3. The details of the check are listed.

How do I check the accessibility of my presentation?

If you have design elements that are 
purely aesthetic, you will need to 
categorize them as decorative.

1. Go to the Review tab and select 
Accessibility.

2. Click on Mark as Decorative. 
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Limitations with color and design choices

Contrast creates emphasis
and is mostly about size and color

White/negative space
is the area between design elements as well as the space within an individual 
design element.

• Signifies refinement and ensures a quality user experience

• Serves as a tool to balance design elements and better organize content to 
improve the visual communication experience
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